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The recording and analysisof eye movements are impor-
tant research tools in such areas as neuroscienceand vesti-
bular and oculomotor control. Quantifying the position of
the eyes and the pattern of eye movements has been criti-
cal for understand visual and cognitive behaviors, includ-
ing visual search (Gitelman, Parrish, Friston, & Mesulam,
2002; Rayner, 1995), driving (Land & Lee, 1994), reading
(Rayner, 1995), and arithmetic (Suppes, 1990), among oth-
ers. These few examples touch on only a tiny fraction of
the large numberof experiments that utilizeeye movements.

Eye-tracking hardware has shown steady improvements
over the last decade. Units employing infrared technology
are noninvasive,are generally easy to use, and are marketed
by over a dozen companies (Wooding, 1999). Although
manufacturers of eye-trackingequipmentgenerally include
software for analyzing eye movements, the programs are
usuallyproprietary, nonextensible(i.e., they cannot analyze
data from other systems), and nonmodifiable in the sense
that the user cannot add additionalanalysesor modify the al-
gorithms. Furthermore, because eye movement datasets are
frequently quite large, memory limitations may make them
difficult to analyze in standard spreadsheet programs. The
developmentof an extensiblesoftware platform for analyz-
ing eye movements therefore became critical for our own
research. This article describes a software program, ILAB,

designed to fill this need. It has been developed in our lab-
oratory and is freely available to other investigators.

Two events helped shape the development of the ILAB
software. The first was the increasing distribution of
“free” software throughout the 1990s on the basis of the
principles of the Free Software Foundation (http://www.
fsf.org/philosophy/free-sw.html; Williams, 2002). Exam-
ples of programs that followed these principles include
Statistical Parametric Mapping (SPM; Frackowiak, Fris-
ton, Frith, & Dolan, 1997; Friston, Ashburner, Heather,
Holmes, & Poline, 1994–2002) and Analysis of Func-
tional NeuroImages (AFNI; Cox, 1996) for the analysis of
functional imaging data and the Psychophysics Toolbox
(Brainard, 1997; Pelli, 1997) for psychological stimulus
display and data collection. All three programs have been
used in hundreds, if not thousands, of laboratories world-
wide. An important aspect of this manner of program dis-
tribution is that users are allowed, indeed encouraged, to
adapt and improve the program as dictated by their needs.
This principlepromotes two-way interactionsbetween the
developerand the users and potentiallyenables more rapid
bug fixes and program improvements that would have
been difficult to implement had the developer worked in
isolation (Williams, 2002).

The second important event leading to the development
of ILAB was the availabilityand increasing sophistication
of the MATLAB (Mathworks, Natick, MA) software en-
vironment. This software is designed around linear alge-
bra principles and is able to work with large datasets (such
as eye movement data). It includes tools for algorithm de-
velopment (a high-level interpreted language) and enables
the rapid design of advanced graphical interfaces. In addi-
tion, many additional toolboxesof prepackaged algorithms
(e.g., signal and image processing, statistics, error mini-
mization, curve fitting, system identification,wavelet, etc.)
are available for the MATLAB software platform. How-
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ever, in order to make ILAB accessible to the widest au-
dience, the program was designed to run with only the de-
fault set of MATLAB toolboxes.Therefore, the user does
not need to make additional purchases beyond a basic
MATLAB license.

ILAB could have been written in a low-level computer
language such as C, which would have freed it from de-
pendency on other software. However, although low-level
languages are very powerful and flexible, they are not as
conducive to rapid program development or easy imple-
mentation of graphical interfaces. Interpreted languages,
such as BASIC, allow easier program development than
do low-level languages but still do not include all the
prepackaged algorithmic and graphical tools in the basic
version of MATLAB. Thus, MATLAB was chosen for its
relative ease of use and because it was one of the few soft-
ware packages of its type available at the time ILAB was
first being developed in 1995.

The specific goals in designing ILAB were the follow-
ing: (1) to displaybasic eye movementdata, includingscan-
paths, fixations, and saccades; (2) to allow basic quantifi-
cation of analyzedeye movement data, includingtabulation
of fixations and saccades and correlation of eye position
with a region of interest (ROI); (3) to allow accurate map-
ping between the eye tracker and the computerscreen; (4) to
enable display of eye movement data on the same images
as those the subject was viewing; (5) to display pupil size
data; (6) to enable export of data and results to facilitate
analyses in other applications; (7) to apply any of the pre-
ceding methods to a variety of eye-tracking systems; and
(8) to developa systemthat allowed expandabilityover time.

Program Design
ILAB takes advantage of MATLAB’s ability to define

data structures, which permits the association of various
types of related information. For example, one can main-
tain an associationbetween a subject number, a study date,
and eye movement data within the same data structure.
This organization facilitates program design by having re-
lated data linked together. The three main data structures
in ILAB are the following: the ILAB structure, which con-
tains raw data, subject information, and the coordinate
mapping from the eye tracker to the computer screen co-
ordinates; the PLOTPARMS structure, which contains infor-
mation about the display of various types of data and cal-
culation results; and the ANALYSISPARMS structure, which
contains parameters for performing various calculations
and the results of those calculations.

Figure 1 is a diagram of the overall design of the ILAB
program. All eye movement data are first converted into
the fields stored in the ILAB variable and saved to disk in
MATLAB’s native mat-file format. This allows rapid load-
ing of the data for future analyses and the ability to quickly
access the original data for all calculations. The mat file
is also hardware independent, enabling data to be ana-
lyzed on any platform that runs Version 5.2 or later of
MATLAB. The four fields in the ILAB variable that must
be filled in are the eye data, an index for each trial, the ac-

quisition rate, and the coordinate system. The eye data
field is an n 3 4 array1 in which the first two columns de-
fine the horizontal and vertical eye positions and the third
contains numerical flags allowing the partitioning of the
dataset into time-limitedsubsets or trials or permitting time-
locking of the eye data to external events. The fourth col-
umn contains information about pupil size when it is
available.

The definitionof trials is an important feature of ILAB,
since it allows the user to designate an association be-
tween particular time intervals in an experiment and a cor-
responding set of eye movement data points. The desig-
nation of specific intervals of eye movement data for each
trial is contained in the index field. The index field is for-
matted as an m 3 3 array, in which m is the number of tri-
als and the three columns represent row indices to the data
corresponding to the start, stop, and (if needed) target
points for each trial. Figure 2A illustrates the eye data or-
ganization, and Figure 2B shows the organization of the
index variable. Setting up this index field can be done au-
tomatically, if the user has instructed the eye-trackingpro-
gram to delineate the trials. It can also be done manually
by designating the start and the end of each trial, using a
graphical editor within ILAB.

The third required field in the ILAB variable is the ac-
quisition rate. This is the speed at which data points are ac-
quired. This is generally between 60 and 1000 Hz for typ-
ical infrared-basedeye trackers and is assumed to beconstant
throughout an experiment. The inverse of the acquisition
rate is the durationof each data point in milliseconds (e.g.,
1/60 5 16.67 msec per data point), providing a built-in
time reference for the data.

Coordinate Transformation
Coordinate transformation of the data is necessary be-

cause the eye tracker screen coordinates may not map in a
one-to-one fashion to the computer screen coordinates. In
addition, the central axes of each screen may not be
aligned. Thus, the eye tracker and computer screen do not
line up precisely at any particular point, such as 0,0 or the
center of each screen. This calibration is entirely separate
from determining a subject’s direction of gaze or point of
regard (POR), which maps the subject’s eye position as
measured by the pupil center and corneal reflection posi-
tions to points the subject is fixating. POR calibration is
not currently part of the ILAB package.

The user must determine the eye tracker to computer
mapping empirically by measuring the location of an ob-
ject on both screens. Tests of both ISCAN (Burlington,
MA) and ASL (Natick, MA) infrared eye-tracking sys-
tems show that the computer to eye tracker mapping is
well approximatedby a set of independentlinear equations
for the horizontal and vertical directions. These equations
are solved using least squares.

MATLAB is very fast at applying the coordinate trans-
formations to a matrix of values and takes only 0.05 sec to
transform 100,000data points on an 800-mHz Pentium III
machine. The accuracy of this transformation is, on aver-
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Figure 1. Diagram of variables and methods in ILAB. This figure serves as both a flowchart and a struc-
tural depiction of the ILAB program. An analysis always starts with converting the raw data into the na-
tive ILAB format—that is, the ILAB variable. Converted datasets can be saved as MATLAB “mat” files and
rapidly reloaded at another time. There are four main program sections: data input and storage, coordi-
nate transformation, analysis, and display. Dotted/dashed lines delineate each section. There are three
main global data structures in ILAB (shown by the gradient filled icons). The ILAB variable stores raw
data; ANALYSISPARMS stores both parameters and results of various analyses; and PLOTFARMS stores infor-
mation associated with different displays. A summary of information contained within each variable is
listed next to it. This organization provides a convenient way for developers to access the data and to store
information related to calculations and display. Input methods are indicated by parallelogram icons under
data input and storage, calculation methods are indicated by rounded rectangles, and display methods are
indicated by angled ovoid icons at the bottom of the figure. The list next to Main Display is the type of in-
formation that may be displayed in the main plot area.
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age, in the subpixel range. Accuracy was determined by
comparing the results obtained by direct measurement of
object locations on the computer screen with object loca-
tions determined by the linear equations. For the ISCAN
(512 3 512) to PC (640 3 480) transformation, the max-
imum absolute error was 1.5 pixels horizontally and 1.1
pixels vertically.The mean absolute error (6SD) was 0.56
6 0.29 pixels horizontally and 0.58 6 0.39 pixels verti-
cally, with a mean absolute total vectorial error of 0.88 6
0.32 pixels (Ï(0.56)2 1 (0.58)2 ). In our setup, 1 pixel
corresponds to 0.02º of visual angle; thus, coordinate
transformation error is over an order of magnitude less
than the measurement error of a standard infrared system.
A similar linear coordinate transformation has been pro-
posed previously for this calculation (Duchowski et al.,
2000). Of note, this type of coordinate transformation is
device independent as long as the video setup does not
warp either the computer or the eye tracker screens non-
linearly. Thus, one can transform eye tracker coordinates
to nearly any screen resolution.

The PLOTPARMS variable (Figure 1) containsuser-settable
preferences regarding the display of the data. It also con-
tains a copy of the data following coordinate transforma-
tion and following the performance of any analyses on the
data. The plottingroutines are then able to use the contents

of PLOTPARMS for display. ANALYSISPARMS containsprefer-
ences for performing various calculations and stores the
results of those calculations for rapid redisplay. The dis-
play section at the bottomof Figure 1 lists a variety of ways
to display the eye movement data.

Graphical Interface
The main ILAB program screen, after loading a dataset,

is shown in Figure 3A. The legend in the upper left indi-
cates the name of the dataset, the dataset type, and the key
to any colors or symbols that are used in the main plot.
The lower left of the main window contains a set of con-
trols allowing the user to display any subset of trials and
previouslycalculated results. Note that some of the check-
boxes are grayed out because calculations have not been
performed or, in the case of pupil data, are not available in
this dataset.

The menus in ILAB (not shown) enable the user to ac-
cess all of its functions. In brief, the File menu allows con-
verting the raw data files, loading converted data files,
loadingadd-on toolboxes,and printing.The Edit menu al-
lows the user to change various properties of the dataset
and to change display preferences. The Analysis menu
contains the various types of analyses for manipulatingthe
data. After an analysis has been run, the appropriate sub-

Figure 2. Internal organization of the data (A) and index (B) variables. The
point# column has been included for illustration purposes. It is not present
in the actual variable. The boundaries of two trials are delineated in panel A,
and their respective indices are given in panel B. Trial 1 has a target marked
at data point 53. This might be an external event (e.g., a target) that should
be specifically time-locked to the data stream. The absence of any target event
in Trial 2 is coded as a 0.
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Figure 3. (A) ILAB main display window. The legend is in the upper left, and plot controls are in the lower right of the display. The
user can display trials individually by clicking the trial slider, or several trials can be entered into the trial edit box. Checkboxes are
used to show or hide various display options. Some checkboxes (pupil, ROI, and segments) are grayed out because the calculations
have not been done for this particular dataset or the data are not available (for pupil size). The main plot area, upper right, is a graph
of eye position. This has been overlaid on a collapsed image of the stimuli shown to the subject. In this case, the subject followed indi-
vidual upright crosses (1) to one of five positions. The lower graphs in panel A show x (horizontal) and y (vertical) eye positions ver-
sus time. Fixations are delineated on the eye position plot as circles and on the time plots by thicker black lines. The center of each cir-
cle is the arithmetic mean of the eye position during a fixation. The diameter of each circle is proportional to the display time relative
to other fixations in that trial. The arrows point to two short segments of data that are missing owing to the subject’s blinking. The
fixation algorithm is relatively resistant to this type of data interruption. In this case, the fixations appropriately spanned this gap in
the data. (B) Velocity plot window. The upper two graphs show the horizontal and the vertical eye velocity. The lower graph shows the
vectorial velocity (i.e., Ï(horiz.vel.)2 1 (vert.vel.)2. Saccades are indicated by lighter gray lines on the lower graph. These saccades cor-
respond to the ones shown in the position versus time eye movement traces in the lower part of panel A. The beginning and the end of
each saccade are indicated by triangles, and the peak is indicated by an asterisk. In the actual display, the saccade is colored red.
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menus under Windows are enabled so the user can reex-
amine any calculated results. Annotationscan be added to
the graphs by using the Tools menu. The ILAB-Help
menu brings up a help file covering all aspects of using
ILAB. This help file has been integrated with MATLAB’s
help facility and is written in HTML.

Visualization Tools
The ILAB main window allows a number of simple dis-

plays for visualizing data. In the upper right of the main
window is the Coordinate Plot Area. Horizontal and ver-
tical POR data are plotted in this section (scanpath in Fig-
ure 3A). Data points can be plotted (relatively) instanta-
neously or at various speeds to allow the user to visualize
the eye movementsover time within each trial. The user can
also set up images to be displayed at the same time as the
data, allowing dynamic visualizationof both the scanpath
and the exact scene that was shown to the subject. Image
display is encoded through an image management dialog
(not shown), which allows the user to choose an image and
assign it a trial and time of display. ILAB is able to read
the image types currently supported by MATLAB, in-
cluding JPEG, TIFF, GIF, BMP, PNG, HDF, PCX, and
XWD.

Relative movement visualization (Rel. Movement in
Figure 3A) colors the scan path segments red or green on
the basis of whether the horizontal vector of the eye move-
ment was directed to the right or the left, respectively. This
type of plot has been valuable for visualization of eye
movements in patientswith neglect, for example. The seg-
mented plot displays the POR data segmented by either
absolute or relative time in a trial. Segments are indicated
by using different colors for various time intervals in a
trial. This display can show where subjects are looking at
particular time intervals in a trial (LaBar, Mesulam, Gitel-
man, & Weintraub, 2000). Additional display options in-
clude showing fixations, saccades, and ROIs.

Analyses
ILAB contains algorithms for a variety of basic analy-

ses, such as delineating fixations and saccades, which are
fundamental to examining eye movements. Associations
between eye movements and one or more user-defined
ROIs can also be examined. Gaze analysis is just a special
case of ROI analysis that is particularly geared toward
checking the maintenance of fixation during a trial. Blink
removal and filtering (smoothing) allows the removal of
certain types of artifacts in the data. The user has the op-
tion of exporting the calculated results or the raw data in
order to allow calculations in other programs—for exam-
ple, statistical software. The various analyses will be dis-
cussed further below.

Although the fixation and saccade algorithmshad been
previously validated (Fischer, Biscaldi, & Otto, 1993;
Salvucci & Goldberg, 2000; Widdel, 1984), a dataset was
collected to display the results of different analyses. The
data were acquired using the RK-426 infrared video eye-
tracking system (ISCAN, Burlington, MA) at 60 Hz. The
subject was instructed to follow an upright cross (1) as it

moved to one of five locations on the screen and, other-
wise, to keep her eyes fixed on the cross. The fixation pe-
riods lasted from 500 to 3,250 msec. There were 100 fix-
ation periods. The subject was also instructed to blink her
eyes whenever the cross changed color from black to red
and back, which occurred 56 times during the 3-min 25-
sec experiment.

Fixations. Fixations are calculated using the moving
window algorithm described by Widdel (1984) and later
reviewed by Salvucci and Goldberg (2000) as an example
of a dispersion-type algorithm. As compared with a vari-
ety of other methods for identifying fixations, including
those based on velocity, hiddenMarkov models, minimum
spanning trees, and areas of interest, Widdel’s algorithm
was found to be accurate, robust, reasonably fast, and fairly
easy to implement (Salvucci & Goldberg, 2000; Widdel,
1984). However, this algorithm is sensitive to the choice
of parameters defining a fixation, includingthe maximum
horizontal and vertical eye movements and the minimum
duration of the fixation (Karsh & Breitenbach, 1983).
Thus, it is important for the user to define these parame-
ters on the basis of the experimental goals and type of
equipment and to keep these parameters constant across
subjects in an experiment (Karsh & Breitenbach, 1983).
ILAB allows the user to define and save these parameters
in order to standardize this analysis. The algorithm is also
relatively resistant to the presence of missing points—for
example, owing to eye blinks (see Figure 3A)—by skip-
ping over these intervals as long as the POR remains
within the developingfixation cluster before and after the
loss of data. If the POR leaves the cluster, a new fixation
is searched for.

Figure 3A shows the locationsof fixations(gray circles)
plotted on 10 sec of a subject’s scanpath. This has been
overlaid on a composite image of the targets. The fixation
circle sizes are proportional to the fixation duration. The
user has the option of showing one or more fixation loca-
tions on the display. Overall, ILAB found 103 fixations. It
identified all 100 predefined fixation periods correctly.
The 3 additionalfixationswere caused by eye blinks’ split-
ting a longer period of fixation. This occurred only three
times out of a total of 56 predefined blinks. The perfor-
mance of the blink algorithm is illustrated further below.

Saccades. Saccades are calculated using an algorithm
outlined by Fischer et al. (1993). The algorithm first
searches for intervals during which the eye’s velocity ex-
ceeds a threshold (e.g., 30–40 deg/sec), as a first pass de-
finition for locating a saccade. Within each interval, the
peak velocity is located, and the final bounds of the sac-
cade are those points that equal or exceed 15% of the peak
velocity. Calculation of saccades at 60 Hz, as shown in
Figure 3, is a highly debated topic in the eye movement lit-
erature (Karn, 2000), and its usefulness depends on the
size of saccades being studied. The algorithm used in
ILAB was originally validated at a 1-kHz acquisition rate
(Fischer et al., 1993). When used at other acquisition
rates, the velocity display (Figure 3B) in ILAB allows the
user to assess the performance of the algorithm. In the ex-
ample shown, with an initial threshold of 40 deg/sec, the
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saccade algorithm found the exact number of saccades
made by the subject (101) after blinks were filtered from
the datastream.

Figure 3B illustrates the velocity plot display of ILAB,
showing a 10-sec interval of eye movements. The lighter
gray lines in the lower trace identify saccades. The upper
traces are velocity versus time plots for the horizontal and
the vertical directions, respectively.

Eye blinks. During eye blinks, the eye tracker loses
track of the pupil center and corneal reflection. Because
eye blinks are not instantaneous, the amount of data loss
can be variable. Furthermore, when the eye opens and the
pupil and corneal positions are reacquired, there are fre-
quently distortions in the eyes’ calculated POR as they ro-
tate back to their original positions (Calkins, Katsanis,
Hammer, & Iacono, 2001). A particularly dramatic exam-
ple of these distortions is shown in Figure 4A.

Eye-tracking systems deal with this loss of eye position
information in a variety of ways. The ISCAN system
(ISCAN, Burlington,MA), for example, tendsnot to show
a pupil size of 0 during the blink,and the eyes’ positionmay
or may not be marked as invalid. Although ASL systems

(ASL, Natick, MA) usually mark the pupil size as 0 during
a blink, incorrect eye position information may still not be
marked as invalid.In order to remove eye blinkartifacts from
the data, two methods have been used: (1) filtering the data
by incorrect position information and (2) filtering by 0
pupil size. For the first method, data points are eliminated
when they are outside the bounds of the computer screen.
The second method eliminates those data points at which
the pupil size is 0. The combinationof these two strategies
can be quite effective at minimizingblink-related artifacts
(Figure 4B). When a user selects both methods, the data
are examined recursively to fulfill both criteria.

Figure 4C displays a close-up of one eye blink from the
dataset used for fixationand saccade analysis.Note the loss
of eye data during the blink and the increased apparent ve-
locity (exceeding 50 deg/sec) at the onset and offset of the
blink. Thus, the eye blink would have both interrupted an
ongoingfixationand havebeen scored as a saccade if not fil-
tered.The result of filtering is shown in Figure 4D. The parts
of the eye blink filtered out are colored gray, and double-
headed arrows indicate the limits of the blink. This interval
either can be marked as missing data or can be interpolated.
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Figure 4. (A) An example of data, from another experiment, heavily contaminated by blink artifacts (data pro-
vided by Zina Manjaly, Institute for Medicine, Research Centre, Jülich, Germany). The subject was making hor-
izontal and vertical eye movements on alternate trials. The various lines extending beyond the central dark cross
of eye movements all represent blink artifacts. (B) Same data as in panel A, with blink artifacts removed by the
blink filter. (C) High-resolution view of a single blink artifact. These data were identical to those used for fixation
and saccade analysis. Note the interval of missing data, surrounded by distorted eye position data displaying a
high velocity. (D) Same data as those in panel C, showing the artifact to be removed by blink filtering (indicated
by the double arrowheads). The gap in eye data can be either left empty or filled in by interpolation. Both options
are available in ILAB.
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ROI analysis and filtering. Another important analy-
sis included in the ILAB system is the ability to define
multiple ROIs and to correlate time, scanpath distance, or
fixations with each of the ROIs. Finally, one has the abil-
ity to filter (i.e., smooth) the eye movement or pupil size
data. Although many infrared eye-tracking systems filter
the eye movement data automatically, most do not filter
pupil size, even though these data can be quite noisy. Sim-
ple filters are included with ILAB, and the user can add
additional filters.

Development
One goal of the ILAB system is to enable users to add

their own tools. This has been enabled in several ways.
(1) ILAB’s source is open and modifiable by the user.
(2) Gateway functions are provided for properly access-
ing and setting the program’s main global variables (ILAB,
PLOTPARMS, and ANALYSISPARMS). (3) Finally, a simple
toolbox system is provided wherein folders added under
the $ILAB/toolbox2 directory tree are recognized and
added to a toolbox submenu upon starting ILAB. For a
toolbox to be recognized an m-file has to have the same
name as the toolbox and reside within the toolbox’s folder.
For example, a toolbox called test would have the file
test.m located within the folder $ILAB/toolbox/test. Upon
selection of the toolbox from the menu, its directory path
is added to MATLAB’s path, and the test.m file is exe-
cuted. A similar strategy has proven to be successful for
implementingadd-ons to the SPM software (Friston et al.,
1994–2002).

Conclusion
ILAB provides a flexible and powerful software foun-

dation for analyzing eye movements. The program uses a
simple, menu-driven, graphical user interface that allows
the user maximum flexibility in defining the parameters
for analysis and display. Basic eye movement analyses
(fixations, saccades, ROI-based) are included in the pack-
age, as well as additional methods for conditioning the
data, exporting data and results, and annotating the dis-
play. The use of the MATLAB software environment af-
fords the user the ability to read and modify the code and
the power of all the standard MATLAB tools. ILAB is in
daily use in our laboratory (Gitelman et al., 1999; Gitel-
man, Parrish, LaBar, & Mesulam, 2000). Since its release
to the public in early 2002, it has been downloadedby over
100 other laboratories. It is hoped that the open-source
model will contribute to the ongoing improvement of the
program and its widespread use. ILAB may be accessed
via the URL at http://www.brain.northwestern.edu/ilab.
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NOTES

1. The notation n 3 4 refers to n- rows and 4 columns.
2. $ILAB refers to the location of the main ILAB folder within the di-

rectory tree.
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